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Changing Help Preferences
By default, documentation access from TIBCO Business Studio™ for BusinessWorks™ is
online, through the TIBCO Product Documentation website that contains the latest version
of the documentation. Check the website frequently for updates. To access the product
documentation offline, download the documentation to a local directory or an internal web
server and then change the help preferences in TIBCO Business Studio for BusinessWorks.

Before you begin
Before changing the help preferences to access documentation locally or from an internal
web server, download the documentation.

1. Go to https://docs.tibco.com/

2. In the Search field, enter TIBCO ActiveMatrix BusinessWorks™ and press Enter.

3. Select the TIBCO ActiveMatrix BusinessWorks™ product from the list. This opens the
product documentation page for the latest version.

4. Click Download All.

5. A compressed .zip file containing the latest documentation is downloaded to your
web browser's default download location.

6. Copy the .zip file to a local directory or to an internal web server and unzip the file.

To point to a custom location:

Procedure
1. Perform one of the following steps in TIBCO Business Studio for BusinessWorks based

on your operating system:

l On Windows OS: Click Window > Preferences

l On macOS: Click TIBCO Business Studio > Preferences.

2. In the Preferences dialog, click BusinessWorks > Help.

3. Click Custom Location, and then browse to the html directory in the folder where
you extracted the documentation or provide the URL to the html directory on your

https://docs.tibco.com/
https://docs.tibco.com/
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internal web server.

4. Click Apply, and then click OK.
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Introduction
TIBCO ActiveMatrix BusinessWorks™ 6.x architecture provides a migration path for
ActiveMatrix BusinessWork™ 5.x projects with a few exceptions. This document explains
how to migrate from ActiveMatrix BusinessWorks 5.x to ActiveMatrix BusinessWorks™ 6.x,
and lists differences between the two. There are many new features in ActiveMatrix
BusinessWorks 6.x that advance integration, but are not covered in this document.

Migration Queries Resolution

ActiveMatrix BusinessWorks 5.x constructs
migrating to equivalent ActiveMatrix
BusinessWorks 6.x constructs.

The value Supported is mentioned in
the "Migration Support" for this
category.

Note: Supported does not mean
defect free.

ActiveMatrix BusinessWorks 5.x constructs are not
migrating to ActiveMatrix BusinessWorks 6.x,
because corresponding ActiveMatrix BusinessWorks
6.x construct is available with corresponding
migration support, with corner case limitations.

The value Supported with limitations
is mentioned in the "Migration Support"
for this category.

The corresponding ActiveMatrix BusinessWorks 6.x
constructs are not currently available.

1. This implies a feature parity gap
for ActiveMatrix BusinessWorks 6.x
compared with ActiveMatrix
BusinessWorks 5.x.

2. The value Currently not
supported is mentioned in the
"Migration Support" for this
category.

Note: Contact Product Management
for details on features that are
currently not supported.
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Migration Queries Resolution

The corresponding ActiveMatrix BusinessWorks 6.x
construct is available, but ActiveMatrix
BusinessWorks 5.x to ActiveMatrix BusinessWorks
6.x migration extension is currently not available.

1. This means a user can create such
a construct using TIBCO Business
Studio for BusinessWorks, but
automated migration from
ActiveMatrix BusinessWorks 5.x is
not yet supported.

2. After migration, re-factor and re-
create the construct using TIBCO
Business Studio for
BusinessWorks.

3. The value BW6 migration not
supported is mentioned in the
"Migration Support" for this
category.

Fundamental design improvements in ActiveMatrix
BusinessWorks 6.x renders automated migration.

1. You can achieve better results in
ActiveMatrix BusinessWorks 6.x
compared to ActiveMatrix
BusinessWorks 5.x, but only when
the construct is created in TIBCO
Business Studio for
BusinessWorks.

2. After migration, re-factor and re-
create the construct using TIBCO
Business Studio for
BusinessWorks.

3. The value Refactor and recreate
is mentioned in the "Migration
Support" for this category.
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Type Column Legends
The following values are used in the "Type" columns.

Values used in
Type columns

Description

.<resource
extension>

The file extension used to describe its type. For example, .xml, .xsd, and
.wsdl resources.

Adapter Specific
Resource

Special resources used only for configuration of Adapters.

Shared
Configuration

Resource configuration with an associated a transport state that can be
lifecycled.

Shared
Resource

Re-usable configuration without a transport state that can be lifecycled.

Process Starter
Activity

1. One of the three activity types supported by ActiveMatrix
BusinessWorks 5.x and ActiveMatrix BusinessWorks 6.x.

2. This type of activity starts a new job from external messages or
internal events.

Regular Activity 1. One of the three activity types supported by ActiveMatrix
BusinessWorks 5.x and ActiveMatrix BusinessWorks 6.x.

2. This type of activity processes its input in-memory.

Signal-in
Activity

1. One of the three activity types supported by ActiveMatrix
BusinessWorks 5.x and ActiveMatrix BusinessWorks 6.x.

2. This type of activity suspends the job and waits for an external
event. When BusinessWorks runtime receives an external event, it
correlates the event base on a prescribed key. The ActiveMatrix
BusinessWorks runtime joins the external event to the waiting job
only when the prescribed key matches.
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Values used in
Type columns

Description

Built-in 1. An intrinsic built-in feature of ActiveMatrix BusinessWorks process
editor.

2. A built-in feature can be from an eclipse or part of the editor feature
(for example, ActiveMatrix BusinessWorks 6.x Process Design Editor).

Palette 1. In ActiveMatrix BusinessWorks 5.x, a palette is a TIBCO Designer™
concept for the grouping of resources or activities.

2. For the purpose of this documentation, a palette is for describing a
group of activities that are offered as part of core ActiveMatrix
BusinessWorks.

Plug-in 1. In ActiveMatrix BusinessWorks 5.x, a ActiveMatrix BusinessWorks
Plug-in is an add-on extension that contains both design-time and
runtime extensions of ActiveMatrix BusinessWorks activities.

2. In ActiveMatrix BusinessWorks 5.x, a ActiveMatrix BusinessWorks
Plug-in is offered as an add-on product to ActiveMatrix
BusinessWorks.

3. For the purpose of this documentation, a plug-in is for describing a
ActiveMatrix BusinessWorks add-on product.

Binding 1. In ActiveMatrix BusinessWorks 6.x, binding type is offered as a first
class concept as part of activities.

2. SOAP binding and REST binding are offered as a part of ActiveMatrix
BusinessWorks 6.x core features.
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Standard Constructs
The following table lists supported standard constructs.

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

DTD .dtd XSD .xsd Supported l ActiveMatrix
BusinessWorks 6.x
currently does not
support DTD natively.

l ActiveMatrix
BusinessWorks 6.x
Migration tool
converts DTD
resource to XSD.

Instance .xml Instance .xml Supported Migrates as is.

Schema .xsd Schema .xsd Supported Migrates as is.

XSLT .xslt XSLT .xslt Supported Migrates as is.

WSDL .wsdl WSDL .wsdl Supported Migrates as is.
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TIBCO ActiveMatrix BusinessWorks™ Core
Constructs
The following table displays supported core constructs.

BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

Design-
time
Library

Application
Module

Application
Module

Supported

Start Start Start Supported Applies to a Sub
Process. If the Sub
Process refers to
an inline schema it
is externalized.

Process
Starter

Process
Starter
Activity or
Service

Process
Starter
Activity or
Service

Supported If the ActiveMatrix
BusinessWorks 5.x
activity is a SOAP
Event Source or a
Service Binding
then the Service is
created. For all
other Process
Starters, it creates
the Process
Starters only.

End End End Supported Applies to a Sub
Process. If the Sub
Process refers to
an inline schema it
is externalized.
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

Global
Variable

.substvar Process
Property

Module
Property

Application
Property

.substvar Supported As ActiveMatrix
BusinessWorks 6.x
Runtime supports
multiple
applications, it is
recommended that
Global Variable is
not used to
describe
application
configurable
properties.

Instead, there are
following three
levels of properties:

l Process
Properties

l Module
Properties

l Application
Properties

These three levels
of properties are
hierarchical:
Application
Properties are in
the outer most
scope, followed by
Module
Properties,
followed by
Process
Properties.
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

You can define and
source value from
its parent scope.
For example:

1. Process
Property
values can
be defined
by Literal
Values or
source its
value from
its parent
scope
Module
Property.

2. By the same
token,
Module
Property
value can be
defined by
Literal
Values or
source from
its parent
scope
Application
Property.
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Groups
BW 5.x BW 5.x

Type
BW 6.x BW 6.x

Type
Migration
Support

Group Built-In Scope Built-In Supported

Group : If Built-In - - Currently not
supported

Group : Iterate Built-In Group : Iterate Built-In Supported

Group : Repeat Until True Built-In Group : Repeat Built-In Supported

Group : Repeat On Error
Until True

Built-In Group : Repeat On
Error

Built-In Supported

Group : Transaction Built-In Group : Local
Transaction

Built-In Supported

Group : Critical Section Built-In Group : Critical
Section

Built-In Supported

Group : Pick First Built-In - - Currently not
supported

Group : While True Built-In Group : While Built-In Supported
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Transitions
BW 5.x BW 5.x

Type
BW 6.x BW 6.x Type Migration

Support
Comments

Process
Definition

.process Process .bwp Supported ActiveMatrix
BusinessWorks
5.x .process
files are
migrated as
.bwp files.

Project Designer
Project

Application
Module

Application
Module

Supported

Transition :

Condition
Type :

Success

Built-In Transition :
Condition
Type :
Success

Built-In Supported

Transition :

Condition
Type :

Success
with
condition

Built-In Transition :
Condition
Type :
Success with
condition

Built-In Supported

Transition :

Condition
Type :

Success
with no
matching

Built-In Transition :
Condition
Type :
Success with
no matching
condition

Built-In Supported
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

condition

Transition :

Condition
Type :

Error

Built-In Transition :
Condition
Type : Error

Built-In Supported
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Timer
Timer is a process starter activity that starts the process at a specific time. You can also
specify the processes to be started periodically.

General

The General tab has the following fields.

Field Literal
Value/Module
Property/Process
Property

Description

Name None The name to be displayed as the label for the activity in
the process.

Start Time Yes The day and time to start the process. To run the process
periodically, the start time indicates the first time to run
the process.

The local machine’s time zone is used to determine the
process start. If the project is running on machines in
different time zones, the time zone of the machine where
the project was saved, is used. Use a process property in
this field to provide start times relative to the time zone
where the project is deployed. If you provide a process
property for this field, the format of the specified time
must be: yyyy MMM dd HH:mm:ss z

Run Once None Indicates this process should be run only once on the day
and time indicated by the Start Time field.

If you do not select this check box, the Time Interval and
Interval Unit fields are displayed that you can use to
specify the frequency of the process.
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Field Literal
Value/Module
Property/Process
Property

Description

Time
Interval

Yes The integer indicating the number of units specified in
the Interval Unit field. For example, if a value of 1 is
specified and the Interval Unit field is specified as Hour,
a new process is started every hour beginning at the time
specified in the Start Time field.

l If a value of 2 is specified and the Interval Unit
field is specified as Month, a process is started
every other month, beginning at the time specified
in the Start Time field.

l If the value specified is less than one second (1000
milliseconds), the timer ignores the specified
interval and is triggered once every second.

Note: Using Literal Value, Module Property, and
Process Property in this field, specifies the time
interval in milliseconds and the Interval Unit field is
not displayed.

Interval
Unit

None The unit of time to use with the Time Interval field to
determine how often to start a new process. The units
can be: Millisecond, Second, Minute, Hour, Day, Week,
Month, and Year.

End After None Specify the number of occurrences or the end time here.
Select from the following available options:

l Never: Click the Never radio button if you want to
continuously execute the process instance. For
example, if the Time Interval value specified is 5
and the Interval Unit specified is Second, the
process instance executes every 5 seconds.

l Occurrences: Clicking the Occurrences radio
button displays the Occurrences field. Specify the



TIBCO ActiveMatrix BusinessWorks™ Migration

20 | Timer

Field Literal
Value/Module
Property/Process
Property

Description

number of occurrences of the process instance
execution. This field can be configured with Literal
Value, Module Property, and Process Property.

l End Time: Clicking the End Time radio button
displays the End Time field. Specify the end time
and date when you want the process to end. This
field can be configured with Literal Value, Module
Property, and Process Property.

Description

Provide a short description of the activity.

Advanced

The Advanced tab has the following fields.

Field Description

Sequencing
Key

This field contains an XPath expression that specifies which processes should
run in sequence. Process instances with sequencing keys evaluating to the
same value, are executed sequentially in the sequence the process instance
was created.

Custom Job
Id

This field contains an XPath expression that specifies a custom job ID for
every job in the process instance.

Conversations

You can initiate the conversation here. Click the Add New Conversation button to
initiate multiple conversations.
For more information about conversations, see TIBCO ActiveMatrix BusinessWorks™
Application Development.
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Output

The following is the output of the activity.

Output Item Description

TimerOutputSchema The time the process instance started.

The time is represented by several items in the output schema
indicating:

l Now

l Hour

l Minute

l Second

l Week

l Month

l Year

l Date

l Time

l DayOfMonth

Each of these items uses the appropriate datatype.

Threading Policy Details

The following are the details about the Timer activity threading policy.

Activity Type Multi-
Threaded?

Default
Thread
Count

Thread Count Configuration

ProcessStarter No 1 Not applicable.

The Timer process starter does not generate
multiple events concurrently. You cannot
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Activity Type Multi-
Threaded?

Default
Thread
Count

Thread Count Configuration

alter the default thread count for this
activity.
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Mapper
BW 5.x BW 5.x

Type
BW 6.x BW 6.x

Type
Migration
Support

Comments

XPATH XPATH in
Designer
Mapper

XPATH XPATH in
Eclipse
Mapper

Supported XPATH support in
ActiveMatrix
BusinessWorks 5.x is
limited to XPATH 1.0.

ActiveMatrix
BusinessWorks 6.x
supports XPATH 1.0. For
example, all literal values
used in XPATH 1.0 must
have a corresponding
constructor function
around the literal value.

XSLT XSLT in
Designer
Mapper

XSLT XSLT in
Eclipse
Mapper

Supported XSLT support in
ActiveMatrix
BusinessWorks 5.x is
limited to XSLT 1.0.

ActiveMatrix
BusinessWorks 6.x also
supports XSLT 1.0.

When a repeating element
is mapped to a string
using a filter, and the
xsl:value-of
instruction parameter
has no separator attribute,
and the value of the select
expression is a sequence
of more than one item,
then under XSLT 2.0 all
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

the items in the output
sequence are space
separated, whereas for
XSLT 1.0, all items after
the first element are
discarded.
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BusinessWorks Palettes

General Palette

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Alias
Library

Shared
Configuration

Application
Module with
Java Nature or
Eclipse Java
Plug-In Project

Eclipse Plug-
in Project

Not
Supported

Enterprise
Archive
Resource

Shared
Configuration

ActiveMatrix
BusinessWorks
6.x Application

Eclipse Plug-
in Project

Not
Supported

Folder Generic
Resource

Folder Eclipse Folder Supported

Generic
Image
Resource

Generic
Resource

Generic
Resource

Identity Shared
Configuration

Identity Shared
Configuration

Supported

Library
Builder

.projlib Shared Module Eclipse Plug-
in Project

Not
Supported

In this version
of ActiveMatrix
BusinessWorks
6.x Migration
Framework,
ActiveMatrix
BusinessWorks
5.x Design-
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BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

time Libraries
are migrated
inline, as part
of regular
resources in
Application
Module.

If an
ActiveMatrix
BusinessWorks
6.x developer
wants to reuse
the contents of
the DT Library,
the migrated
resource can
be manually
re-factored
into Shared
Module.

Workaround:
To support
Design-time
libraries after
migration
configure the
libraries and
save them to
the disk before
migrating.

Task List .taskList Task List .taskList Currently
not
supported
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BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Text
Document

.txt Text
Document

.txt Supported

General Activities Shared Resources
ActiveMatrix BusinessWorks 5.x: General Activities Shared Resources

Type: Palette

ActiveMatrix BusinessWorks 6.x: Shared Resources Wizards

Type: Shared Resources

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migratio
n
Support

Comments

Custom
Activity

Shared
Configurati
on

Custom Activity Shared
Configurati
on

Currently
not
supporte
d

JNDI
Configurati
on

Shared
Configurati
on

JNDI Configuration Shared
Configurati
on

Supporte
d

Job Shared
Variable

Shared
Configurati
on

Module : Job Shared
Variable

Shared
Configurati
on

Supporte
d

Lock Object Shared
Configurati
on

Module : Job Shared
Variable

Shared
Configurati
on

Supporte
d

In
ActiveMatrix
BusinessWor
ks 5.x, Lock
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migratio
n
Support

Comments

Object is
used with
the Critical
Section
group. This
construct is
also
supported
for cross
engines
critical
section.

In
ActiveMatrix
BusinessWor
ks 6.x, the
Critical
Section
group is
configured
with Module
Shared
Variable.

In TIBCO
Business
Studio for
BusinessWor
ks, module
shared
variables are
configured
through
Module
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migratio
n
Support

Comments

Descriptors
> Shared
Variables
editor. This
construct is
also
supported
for
AppSpaces
with
multiple
AppNodes in
ActiveMatrix
BusinessWor
ks 6.x, if the
AppSpace is
configured
with Engine
Group
active/active
configuratio
n.

Migration
Tool
migrates
ActiveMatrix
BusinessWor
ks 5.x Lock
Object as a
Module
Shared
Variable and
the Critical
Section
group.
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migratio
n
Support

Comments

Notify
Configurati
on

Shared
Configurati
on

Process :
WSDL/Interface/Oper
ation

Shared
Configurati
on

Supporte
d

Shared
Variable

Shared
Resource

Module : Module
Shared Variable Type:
Shared Resource

Shared
Resource

Supporte
d

ActiveMatrix
BusinessWor
ks 5.x shared
variable with
multi-engine
option is
now a
Module
Shared
Variable with
Persistent
option.

General Activities Palette
ActiveMatrix BusinessWorks 5.x: General Activities Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: General Activities Palette

Type: Palette

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Assign Regular
Activity

Basic : Assign Regular
Activity

Supported

Call Process Regular Call Process Regular Supported
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Activity Activity Activity +
Binding
Type

Catch Regular
Activity

Scope with
Catch Block

Built-in Supported

Checkpoint Regular
Activity

Checkpoint Regular
Activity

Confirm Regular
Activity

Confirm Regular
Activity

Supported

Engine
Command

Regular
Activity

Engine
Command

Regular
Activity

Supported

External
Command

Regular
Activity

External
Command

Regular
Activity

Supported

Generate
Error

Regular
Activity

Basic : Throw Regular
Activity

Supported

Get Shared
Variable

Regular
Activity

Get Shared
Variable

Regular
Activity

Supported

Inspector Regular
Activity

Inspector Regular
Activity

Supported

Label Diagram
Notation

Note Diagram
Notation

Supported

Mapper Regular
Activity

Mapper Regular
Activity

Supported

Notify Regular
Activity

Invoke
Process

Regular
Activity

Supported In ActiveMatrix
BusinessWorks 5.x,



TIBCO ActiveMatrix BusinessWorks™ Migration

32 | BusinessWorks Palettes

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Notify, and Wait
activities are used
for inter-process
communication.

In ActiveMatrix
BusinessWorks 6.x,
a process now
supports interface
with multiple
operations. These
operations can be
used for inter-
process
communication.

When the Notify
and Wait activities
are used for
multiple processes
waiting to receive
notification, you
can use a JMS
transport with
topic to achieve
the same
publish/subscribe
pattern.

Null Regular
Activity

Basic :
Empty

Regular
Activity

Supported

On Error

Type:

Process
Starter
Activity

Currently
not
supported

On Event Process Currently
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Timeout Starter
Activity

not
supported

On
Notification
Timeout

Process
Starter
Activity

Supported

On Shutdown Process
Starter
Activity

Activator
Process

Process Supported Process with a
special
ActiveMatrix
BusinessWorks 6.x
defined service
that supports an
operation for
onShutdown
functionality. This
process can be
configured per
application.

Close, re-open, and
clean the migrated
project to resolve
unresolved schema
references.

On Startup Process
Starter
Activity

Activator
Process

Process Supported Process with a
special
ActiveMatrix
BusinessWorks 6.x
defined service
that supports an
operation for
onStartup an be
configured per
application.



TIBCO ActiveMatrix BusinessWorks™ Migration

34 | BusinessWorks Palettes

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Close, re-open, and
clean the migrated
project to resolve
unresolved schema
references.

Receive
Notification

Process
Starter
Activity

Basic :
Receive

Process
Starter
Activity

Supported

Rethrow Regular
Activity

Basic :
Rethrow

Regular
Activity

Supported

Set Shared
Variable

Regular
Activity

Set Shared
Variable

Regular
Activity

Supported

Sleep Regular
Activity

Sleep Regular
Activity

Supported

Timer Regular
Activity

Timer Regular
Activity

Supported

Wait Signal-In
Activity

Receive Process
Starter

Supported

Write To Log Regular
Activity

Log Regular
Activity

Supported

ActiveEnterprise Palette
ActiveMatrix BusinessWorks 5.x: ActiveEnterprise Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: ActiveEnterprise Plug-in

Type: Plug-in
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Note: In TIBCO BusinessWorks Container Edition, the ActiveEnterprise palette is
not bundled out-of-the-box. You must install the Adapter Framework Pack as an
add-on Plug-in.

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Adapter Request-
Response Server

Process Starter
Activity

Adapter Request-
Response Server

Process Starter
Activity

Supported

Adapter
Subscriber

Process Starter
Activity

Adapter
Subscriber

Process Starter
Activity

Supported

Invoke an Adapter
Request response
Service

Request/Reply
Activity

Invoke an
Adapter Request
response Service

Request/Reply
Activity

Supported

Publish to
Adapter

Regular Activity Publish to
Adapter

Regular Activity Supported

Respond to
Adapter Request

Regular Activity Respond to
Adapter Request

Regular Activity Supported

Send Exception to
Adapter Request

Regular Activity Send Exception
to Adapter
Request

Regular Activity Supported

Wait for Adapter
Message

Signal-In Activity Wait for Adapter
Message

Signal-In Activity Supported

Wait for Adapter
Request

Signal-In Activity Wait for Adapter
Request

Signal-In Activity Supported

Adapter Resources Palette
ActiveMatrix BusinessWorks 5.x: Adapter Resources Palette

Type: Palette
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ActiveMatrix BusinessWorks 6.x: Adapter Resources Plug-in

Type: Plug-in

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Generic
Adapter
Configuration

Shared
Configuration

Generic
Adapter
Configuration

Shared
Configuration

Supported

Message Filter Adapter
Specific
Resource

Message Filter Adapter
Specific
Resource

Supported

Adapter
Archive

Adapter
Specific
Resource

Adapter
Archive

Adapter
Specific
Resource

Supported

Advisory Adapter
Specific
Resource

Advisory Adapter
Specific
Resource

Supported

Client Adapter
Specific
Resource

Client Adapter
Specific
Resource

Supported

Generic Log
Sink

Adapter
Specific
Resource

Generic Log
Sink

Adapter
Specific
Resource

Supported

Generic
Transaction
Control Pool

Adapter
Specific
Resource

Generic
Transaction
Control Pool

Adapter
Specific
Resource

Supported

Generic
Session

Adapter
Specific
Resource

Generic
Session

Adapter
Specific
Resource

Supported

Load URL Adapter Load URL Adapter Supported



TIBCO ActiveMatrix BusinessWorks™ Migration

37 | BusinessWorks Palettes

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Specific
Resource

Specific
Resource

Log Sink Role Adapter
Specific
Resource

Log Sink Role Adapter
Specific
Resource

Supported

Publication
Service

Adapter
Specific
Resource

Publication
Service

Adapter
Specific
Resource

Supported

Publisher Adapter
Specific
Resource

Publisher Adapter
Specific
Resource

Supported

Request-
Response
Invocation
Service

Adapter
Specific
Resource

Request-
Response
Invocation
Service

Adapter
Specific
Resource

Supported

Request-
Response
Service

Adapter
Specific
Resource

Request-
Response
Service

Adapter
Specific
Resource

Supported

Server Adapter
Specific
Resource

Server Adapter
Specific
Resource

Supported

Subscriber Adapter
Specific
Resource

Subscriber Adapter
Specific
Resource

Supported

Subscription
Service

Adapter
Specific
Resource

Subscription
Service

Adapter
Specific
Resource

Supported
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BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Timer Adapter
Specific
Resource

Timer Adapter
Specific
Resource

Supported

BPEL Extension Palette

BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

Orchestration
Process

.orchestration Built-In :
Process

.bwp Supported The
.orchestration
resource is
available in the
BPEL Palette.

ActiveMatrix
BusinessWorks
Process is
natively based
on BPEL.

Assign Regular
Activity

Basic: Assign Regular
Activity

Supported

Catch Regular
Activity

Scope with
Catch Block

Built-In Supported

Checkpoint Regular
Activity

General
Activities:
Checkpoint

Regular
Activity

Supported

Exit Regular Basic: Exit Regular Supported
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BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

Activity Activity

Invoke Regular
Activity

Basic:
Invoke

Regular
Activity

Supported

Invoke Process Regular
Activity

General
Activities :
Invoke
Process +
Reference
Binding

Regular
Activity

Supported

Null Regular
Activity

Basic: Empty Regular
Activity

Supported

On Alarm Process Starter
Activity

Built-In:
Alarm
Handler

Built-In Currently
not
supported

On Event Process Starter
Activity

Built-In:
Event
Handler

Built-In Supported

Receive Starter Process Starter
Activity

Basic:
Receive
(Create
Instance =
true)

Type:
Process
Starter
Activity

Process
Starter
Activity

Supported

Receive Signal-In
Activity

Basic:
Receive

Signal-In
Activity

Supported
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BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

(Create
Instance =
false)

Reply with
Fault

Regular
Activity

Basic : Reply
with Fault
configured

Regular
Activity

Supported

Reply Regular
Activity

Basic: Reply Regular
Activity

Supported

Rethrow Regular
Activity

Basic:
Rethrow

Regular
Activity

Supported

Sleep Regular
Activity

General
Activities:
Sleep

Regular
Activity

Supported

Throw Regular
Activity

Basic: Throw Regular
Activity

Supported

Write To Log Regular
Activity

General
Activities:
Log

Regular
Activity

Supported

File Palette
ActiveMatrix BusinessWorks 5.x: File Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: File Palette

Type: Palette
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BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Copy File Regular
Activity

Copy File Regular
Activity

Supported

Create File Regular
Activity

Create File Regular
Activity

Supported

File Poller Process
Starter
Activity

File Poller Process
Starter
Activity

Supported

List Files Regular
Activity

List Files Regular
Activity

Supported

Read File Regular
Activity

Read File Regular
Activity

Supported

Remove File Regular
Activity

Remove File Regular
Activity

Supported

Rename File Regular
Activity

Rename File Regular
Activity

Supported

Wait for File
Change

Signal-In
Activity

Wait for File
Change

Signal-In
Activity

Supported

Write File Regular
Activity

Write File Regular
Activity

Supported

FTP Palette
ActiveMatrix BusinessWorks 5.x: FTP

Type: Palette

ActiveMatrix BusinessWorks 6.x: FTP Palette

Type: Palette
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

FTP
Connection

Shared
Resource

FTP
Connection
Type: Shared
Resource

Shared
Resource

Supported

FTP Change
Default
Directory

Regular
Activity

FTP Change
Default
Directory

Regular
Activity

Supported

FTP Delete
File

Regular
Activity

FTP Delete File
Type: Regular
Activity

Regular
Activity

Supported

FTP Dir Regular
Activity

FTP Dir Regular
Activity

Supported

FTP Get
Default
Directory

Regular
Activity

FTP Get
Default
Directory

Regular
Activity

Supported

FTP Get Regular
Activity

FTP Get Regular
Activity

Supported

FTP Make
Remote
Directory

Regular
Activity

FTP Make
Remote
Directory

Regular
Activity

Supported

FTP Put Regular
Activity

FTP Put Regular
Activity

Supported

FTP Quote Regular
Activity

FTP Quote Regular
Activity

Supported

FTP Remove
Remote
Directory

Regular
Activity

FTP Remove
Remote
Directory

Regular
Activity

Supported
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

FTP Rename
File

Regular
Activity

FTP Rename
File

Regular
Activity

Supported

FTP Sys Type Regular
Activity

FTP Sys Type Regular
Activity

Supported

HTTP Palette
ActiveMatrix BusinessWorks 5.x: HTTP

Type: Palette

ActiveMatrix BusinessWorks 6.x: HTTP Palette

Type: Palette

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

HTTP
Connection

Shared
Resource

HTTP
Connector

Shared
Resource

Supported HTTP Connection
shared resource is
migrated to
ActiveMatrix
BusinessWorks 6.x
as an HTTP
Connector shared
resource. This is
for the HTTP
Service.

ActiveMatrix
BusinessWorks
uses Jetty Server
and does not
support Tomcat
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

and
HttpComponent
implementation
from ActiveMatrix
BusinessWorks
5.x.

Proxy
Configuration

Shared
Resource

Proxy
Configuration

Shared
Resource

Supported

HTTP Receiver Process
Starter

HTTP Receiver Process
Starter

Supported

Send HTTP
Request

Regular
Activity

Send HTTP
Request

Regular
Activity

Supported ActiveMatrix
BusinessWorks 6.x
has also
introduced a new
shared resource
for this client side
invoke, HTTP
Client shared
resource. You can
use this shared
resource to
configure and
tune a number of
optimization
parameters such
as Maximum
Total Connection
and Maximum
Total Connection
Per Host.

This new HTTP
Client shared
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

resource also
allows the users
to configure a
Thread Pool
shared resource ( 
new in
ActiveMatrix
BusinessWorks
6.x). Using the
Thread Pool
shared resource
you can configure
Minimum Pool
Size, Maximum
Pool Size and a
number of other
tuning
parameters.

Note: After
Axis2 upgrade,
Apache
Commons
client library is
no longer used
in HTTP. The
projects
migrated from
ActiveMatrix
BusinessWorks
5.x shall now
show Apache
Components as
the client
library instead
of Apache
Commons.
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Send HTTP
Response

Regular
Activity

Send HTTP
Response

Regular
Activity

Supported

Wait For HTTP
Request

Signal-In
Activity

Wait For HTTP
Request

Signal-In
Activity

Supported

JAVA Palette
ActiveMatrix BusinessWorks 5.x: JAVA

Type: Palette

ActiveMatrix BusinessWorks 6.x: JAVA Palette

Type: Palette

Note: If the ActiveMatrix BusinessWorks 5.x project has an activity from the Java
palette, the ActiveMatrix BusinessWorks application module gets converted to a
Java project. The additional src and lib folders are seen in the project. The src
folder contains the Java source files. The lib folder contains the Java libraries
(JAR Files). Java Nature is also added to the project.

BW
5.x

BW 5.x
Type

BW
6.x

BW 6.x
Type

Migrati
on
Suppor
t

Comments

Java
Custo
m
Functi
on

Shared
Configura
tion

Custo
m
XPATH
Functi
on

Shared
Configura
tion

Suppor
ted
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BW
5.x

BW 5.x
Type

BW
6.x

BW 6.x
Type

Migrati
on
Suppor
t

Comments

Java
Global
Instan
ce

Shared
Resource

Java
Global
Instan
ce

Shared
Resource

Suppor
ted

Java
Sche
ma

Shared
Configura
tion

XSD
Sche
ma

.xsd Suppor
ted

In ActiveMatrix BusinessWorks 6.x the
Java To XML and XML To Java
activities do not use Java Schema. After
migration the corresponding Schema
equivalent to the Java Schema is
generated and associated with the
activity.

Java
Code

Regular
Activity

Java
Invoke

Regular
Activity

Suppor
ted

The source code for the Java Code
activity which was in-lined in the
ActiveMatrix BusinessWorks 5.x now
gets created externally in the src folder
of the AppModule and then it is
referred by the Java Invoke activity
with MultiOutput check box selected.

Java
Event
Sourc
e

Process
Starter
Activity

Java
Proce
ss
Starte
r

Process
Starter
Activity

Suppor
ted

The Source code for Java Event
Source activity which was in-lined in
the ActiveMatrix BusinessWorks 5.x now
gets created externally in the src folder
of the AppModule and then Java
Process Starter activity refers to it.

The Java class implementing the Java
Event Source now extends
com.tibco.bw.palette.shared.java.J
avaProcessStarter class instead of
com.tibco.plugin.java.JavaProcessS
tarter.
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BW
5.x

BW 5.x
Type

BW
6.x

BW 6.x
Type

Migrati
on
Suppor
t

Comments

Java Event Source in ActiveMatrix
BusinessWorks 5.x referring to an
external class needs to change this.

Java
Metho
d

Regular
Activity

Java
Invoke

Regular
Activity

Suppor
ted

Java
To
XML

Regular
Activity

Java
To
XML

Regular
Activity

Suppor
ted

XML
To
Java

Regular
Activity

XML
To
Java

Regular
Activity

Suppor
ted

JDBC Palette
Starting from ActiveMatrix BusinessWorks 6.10.0 release, the JDBC Progress DataDirect
Drivers are not supported directly. For more information, see "Migrating existing JDBC
applications configured with Progress DataDirect Drivers " in the TIBCO ActiveMatrix
BusinessWorks™ Bindings and Palette Reference.

ActiveMatrix BusinessWorks 5.x: JDBC

Type: Palette

ActiveMatrix BusinessWorks 6.x: JDBC Palette

Type: Palette
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

JDBC
Connection

Shared
Resource

JDBC
Connection

Shared
Resource

Supported

JDBC Call
Procedure

Regular
Activity

JDBC Call
Procedure

Regular
Activity

Supported

JDBC Get
Connection

Regular
Activity

JDBC Get
Connection

Regular
Activity

Currently not
supported

JDBC Query Regular
Activity

JDBC Query Regular
Activity

Supported

JDBC Update Regular
Activity

JDBC Update Regular
Activity

Supported

SQL Direct Regular
Activity

SQL Direct Regular
Activity

Supported

JMS Palette
ActiveMatrix BusinessWorks 5.x: JMS Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: JMS Palette

Type: Palette

BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

JMS
Application
Properties

Shared
Configuration

XSD Schema .xsd Supported JMS
Application
Properties is
migrated as
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BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

XML Schema
(XSD File) in
ActiveMatrix
BusinessWorks
6.x.

JMS
Connection

Shared
Resource

JMS
Connection

Shared
Resource

Supported

Get JMS
Queue
Message

Regular
Activity

Get JMS
Queue
Message

Regular
Activity

Supported

JMS Queue
Receiver

Process Starter
Activity

JMS Receive
Message

Process
Starter
Activity

Supported

JMS Queue
Requester

Regular
Activity

JMS Request
Reply

Regular
Activity

Supported

JMS Queue
Sender

Regular
Activity

JMS Send
Message

Regular
Activity

Supported

JMS Topic
Publisher

Type:
Regular
Activity

Regular
Activity

JMS Send
Message

Type:
Regular
Activity

Regular
Activity

Supported

JMS Topic
Requestor

Type:
Regular
Activity

Regular
Activity

JMS Request
Reply

Type:
Regular
Activity

Regular
Activity

Supported
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BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

JMS Topic
Subscriber

Process Starter
Activity

JMS Receive
Message

Process
Starter
Activity

Supported

Reply to JMS
Message

Type:
Regular
Activity

Regular
Activity

Reply to JMS
Message

Type:
Regular
Activity

Regular
Activity

Supported

Wait for JMS
Queue
Message

Signal-In
Activity

Wait for JMS
Message

Signal-In
Activity

Supported

Wait for JMS
Topic
Message

Signal-In
Activity

Wait for JMS
Message

Signal-In
Activity

Supported

Mail Palette
ActiveMatrix BusinessWorks 5.x: Mail Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: Mail Palette

Type: Palette

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Receive
Mail

Process
Starter
Activity

Receive
Mail

Process
Starter
Activity

Supported
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Send Mail Regular
Activity

Send Mail Regular
Activity

Supported ActiveMatrix
BusinessWorks 6.x
introduces a new SMTP
shared resource.
ActiveMatrix
BusinessWorks 5.x Send
Mail activity
configuration migrates to
both Send Mail activity
and SMTP shared
resource.

Parse Palette
ActiveMatrix BusinessWorks 5.x: Parse Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: Parse Palette

Type: Palette

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Data
Format

Shared
Configuration

Data
Format

Shared
Configuration

Supported

Parse
Data

Regular Activity Parse
Data

Regular Activity Supported

Render
Data

Regular Activity Render
Data

Regular Activity Supported
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Policy Palette
ActiveMatrix BusinessWorks 5.x: Policy Palette

Type: Palette

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

Security
Policy
Association

Shared
Configuration

Security
Policy
Association

Shared
Configuration

Currently
not
supported

Security
Policy

Shared
Configuration

Security
Policy

Shared
Configuration

Currently
not
supported

Process Palette
ActiveMatrix BusinessWorks 5.x: Process Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: Built-In

Type: Built-In

BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

Process
Definitio
n

.process Process .bwp Supporte
d

Process
Archive

Shared
Configuratio
n

Applicatio
n Project

.applicatio
n

Refactor
and
recreate

In ActiveMatrix
BusinessWorks 5.x,
Process Archive is
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

configured within the
Enterprise Archive
Resource. This specifies
which processes in the
ActiveMatrix
BusinessWorks 5.x
project are packaged to
form an .EAR file for
deployment.

In ActiveMatrix
BusinessWorks 6.x, the
Enterprise Archive
Resource and Process
Archive configuration
are no longer supported
and their functionality
are replaced by
Application and
Application Module,
respectively. Any project
artifacts that can be re-
used by multiple
Applications and
multiple Application
Modules are created in
Shared Modules.

In the current version of
Migration Tool, an
ActiveMatrix
BusinessWorks 5.x
project is migrated as
an application module
with a corresponding
application project. If
the content of the
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

ActiveMatrix
BusinessWorks 5.x
project is meant for
creating multiple
applications, then do
the following:

1. Convert the
Application
Module to Shared
Module.

2. Create an
Application
Module and a
corresponding
application
project.

a. In the
Application
Module >
Module
Descriptors
>
Componen
ts editor,
define the
component
to refer to
process
implementa
tion in the
Shared
Module.

b. Repeat 2.a
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x Type Migration
Support

Comments

step for
each
process
that is
required to
be a part of
this
Application
Module. In
ActiveMatrix
BusinessWo
rks 6.x, a
Process
(say,
Process A)
in a Shared
Module is
not
activated
unless a
Component
is defined
and is
configured
with
Process A .

3. Repeat Step 2 for
the number of
applications
required.

Rendezvous Palette
ActiveMatrix BusinessWorks 5.x: Rendezvous Palette

Type: Palette
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ActiveMatrix BusinessWorks 6.x: Rendezvous Palette

Type: Palette

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Rendezvous
Transport

Shared
Resource

Rendezvous
Transport

Shared
Resource

Supported

Publish
Rendezvous
Message

Regular
Activity

Rendezvous
Publisher

Regular
Activity

Supported

Rendezvous
Subscriber

Process
Starter
Activity

Rendezvous
Subscriber

Process
Starter
Activity

Supported

Reply To
Rendezvous
Request

Regular
Activity

Rendezvous
Reply To
Request

Regular
Activity

Supported

Send
Rendezvous
Request

Regular
Activity

Rendezvous
Request Reply

Regular
Activity

Supported

Wait for
Rendezvous
Message

Signal-In
Activity

Wait for
Rendezvous
Message

Signal-In
Activity

Supported

REST and JSON Plug-in
ActiveMatrix BusinessWorks 5.x: REST/JSON Plug-in

Type: Plug-in

ActiveMatrix BusinessWorks 6.x: REST and JSON Palette

Type: Palette

Migration: Supported
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Invoke
REST API

Regular
Activity

Invoke
REST API

Regular
Activity

Supported
with
limitations

ActiveMatrix
BusinessWorks 6.x does
not support the
following:

l WADL protocols

l Responses
returned in binary
format

l Rich output

l Authentication
OAuth1.0 and
OAuth2.0

Note: The Circuit Breaker pattern is not supported by the Invoke REST API activity. If you
want to use Circuit Breaker pattern, you need to configure the REST Reference Binding. For
more information, see Using the Wizard to Create a REST Reference in TIBCO ActiveMatrix
BusinessWorks™ REST Reference.

Parse
JSON

Regular
Activity

Parse
JSON

Regular
Activity

Supported
with
limitations

ActiveMatrix
BusinessWorks 6.x does
not support the schema
type Java Classes.

Render
JSON

Regular
Activity

Render
JSON

Regular
Activity

Supported
with
limitations

The Remove Root
check box is not
supported in
ActiveMatrix
BusinessWorks 6.x. Root
elements in TIBCO
BusinessWorks
Container Edition are
skipped by default. You
must modify the input
JSON if it contains root
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

element.

The schema type Java
Classes is not supported
in ActiveMatrix
BusinessWorks 6.x.

REST
Dispatch
and Reply

Regular
Activity

REST
Service
Binding

Service
Binding

Supported
with
limitations

The ActiveMatrix
BusinessWorks 5.x
Dispatch and Reply
REST activity is
migrated to REST
Service Binding of
ActiveMatrix
BusinessWorks 6.x.

REST Service of
ActiveMatrix
BusinessWorks 6.x uses
XSD as the resource for
building REST Service.
The XSD must be
external to the WSDL.
That is, direct reference
to inline schema in
WSDL is not supported
for REST binding.

If the Dispatch and
Reply activity is
configured to route
requests to ActiveMatrix
BusinessWorks 5.x
processes with inline
schema for its input,
output and fault, then
the ActiveMatrix
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

BusinessWorks 6.x
Migration Tool currently
does not externalize the
inline schema before
configuring the REST
binding. You can
manually externalize the
inline schema and re-
create the REST binding.

ActiveMatrix
BusinessWorks 6.x also
does not support the
following:

l Enable WADL
Reference

l Enable OAuth

l Parameter styles-
Template and
Header

Note: For more information about additional restrictions, see "Restrictions on
XML Schema" in TIBCO ActiveMatrix BusinessWorks™ Bindings and Palettes
Reference.

RMI Palette

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration Support Comments

RMI
Lookup

Regular
Activity

RMI
Lookup

Regular
Activity

Currently not
supported

None
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BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration Support Comments

RMI
Server

Process
Starter

RMI
Server

Process
Starter

Currently not
supported

None

Service Palette
ActiveMatrix BusinessWorks 5.x: Service Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: Built-In

Type: Built-In

Migration: Supported

BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

Context
Resource

.contextResource Built-In Supported Migrated as
Job Shared
Variable

Partner Link
Configuration

.sharedpartner Process :
Reference

Built-In Supported

Service .serviceagent Process :
Service

Built-In Supported

Get Context Regular Activity Basic : Get
Context

Regular
Activity

Supported Post
migration, two
sets of Get
Context and
Set Context
activities are
displayed in a
service
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BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

process. The
sets retrieve
the context
information
and pass the
information to
the
subprocesses,
and vice versa.

Invoke Partner Regular Activity Basic :
Invoke
Service

Regular
Activity

Supported SOAP Request
Reply activity
is migrated as
a process with
reference and
SOAP
reference
binding is
added for the
same. The
binding is
added under
Module
Descriptors >
Components
> Binding.

Receive
Partner
Notification

Process Starter
Activity

Basic :
Receive

Process
Starter
Activity

Supported

Set Context Regular Activity Basic : Set
Context

Regular
Activity

Supported Post
migration, two
sets of Get
Context and
Set Context



TIBCO ActiveMatrix BusinessWorks™ Migration

63 | BusinessWorks Palettes

BW 5.x BW 5.x Type BW 6.x BW 6.x
Type

Migration
Support

Comments

activities are
displayed in a
service
process. The
sets retrieve
the context
information
and pass the
information to
the
subprocesses,
and vice versa.

SOAP Palette
ActiveMatrix BusinessWorks 5.x: SOAP Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: Basic Palette + SOAP Binding

Type: Binding

Migration: Supported

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

MIME
Parser

Regular
Activity

Parse :
MIME
Parser

Regular
Activity

Currently
not
supported

Retrieve
Resources

Regular
Activity

Generate
WSDL
Service

Regular
Activity
+ SOAP

Currently
not
supported

The WSDL in ActiveMatrix
BusinessWorks 6.x has to be
generated in TIBCO Business
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

Binding Studio for BusinessWorks on
the Component Binding.

SOAP
Event
Source

Process
Starter
Activity

Basic :
Receive +
SOAP
Service
Binding

Process
Starter
Activity
+ SOAP
Binding

Supported
with
limitations.

The SOAP Event Source is
migrated as a Process with
Service and a SOAP Service
Binding is added for the same.
The Binding is added under
Module Descriptors,
Components, or Binding.

Currently only Copy-Of binding
is supported for headers in the
Binding section. Manually,
set/map the Input tab of the
Set Context activity to use the
SOAP Event Source activity
header migration functionality.

SOAP
Request
Reply

Regular
Activity

Basic :
Invoke
Service +
SOAP
Reference
Binding

Regular
Activity
+ SOAP
Binding

Supported
with
limitations.

The SOAP Request Reply is
migrated as a Process with
Reference and a SOAP
Reference Binding is added for
the same. The Binding is
added under Module
Descriptors/Components/Bindi
ng.

Currently only Copy-Of binding
is supported for headers in the
Binding section. Manually,
set/map the Input tab of the
Set Context activity to use
the SOAP Request Reply
activity header migration
functionality.
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

SOAP
Send Fault

Regular
Activity

Basic :
Reply with
Fault +
SOAP
Reference
Binding

Regular
Activity
+ SOAP
Binding

Supported

SOAP
Send
Reply

Regular
Activity

Basic
Activities:
Reply +
SOAP
Reference
Binding

Regular
Activity
+ SOAP
Binding

Supported

TCP Palette
ActiveMatrix BusinessWorks 5.x: TCP Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: TCP Palette

Type: Palette

Migration: Supported

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

TCP
Connection

Shared
Resource

TCP
Connection

Shared
Resource

Supported

Read TCP
Data

Regular
Activity

Read TCP
Data

Regular
Activity

Supported
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BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

TCP Close
Connection

Regular
Activity

TCP Close
Connection

Regular
Activity

Supported

TCP Open
Connection

Regular
Activity

TCP Open
Connection

Regular
Activity

Supported

TCP Receiver Process
Starter
Activity

TCP Receiver Process
Starter
Activity

Supported

Wait for TCP
Request

Signal-In
Activity

Wait for TCP
Request

Signal-In
Activity

Supported

Write TCP
Data

Regular
Activity

Write TCP
Data

Regular
Activity

Supported

Transaction Palette

BW 5.x BW 5.x
Type

BW 6.x BW 6.x
Type

Migration
Support

Comments

JTA User
Transaction
Configuration

Shared
Resource

JTA User
Transaction
Configuration

Shared
Resource

Currently
not
supported

XA Transaction
Manager
Configuration

Shared
Resource

XA Transaction
Manager
Configuration

Shared
Resource

Currently
not
supported

Transaction
State

Regular
Activity

Transaction
State

Regular
Activity

Currently
not
supported
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XML Palette
ActiveMatrix BusinessWorks 5.x: XML Palette

Type: Palette

ActiveMatrix BusinessWorks 6.x: XML Palette

Type: Palette

Migration: Supported

BW 5.x BW 5.x Type BW 6.x BW 6.x Type Migration
Support

Comments

XSLT File Shared
Configuration

XSLT File Shared
Configuration

Supported

Parse XML Regular
Activity

Parse XML Regular
Activity

Supported

Render XML Regular
Activity

Render XML Regular
Activity

Supported

Transform
XML

Regular
Activity

Transform
XML

Regular
Activity

Supported
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Migration Scenario
The migration scenarios show the core construct migration of ActiveMatrix BusinessWorks
5.x projects. After migration, these projects are converted to their equivalent in
ActiveMatrix BusinessWorks 6.x. The ActiveMatrix BusinessWorks 6.x Call Process, Signal-
in,Start, and End activities are notably different from the activities in ActiveMatrix
BusinessWorks 5.x.

Call Process Activity Migration

The following table provides information about the Call Process activity migration from
ActiveMatrix BusinessWorks 5.x to ActiveMatrix BusinessWorks 6.x.

ActiveMatrix BusinessWorks 5.x ActiveMatrix BusinessWorks 6.x

Call Process is literal. It calls a process with
process pipeline data mapped into it and
generates an output that is in essence the
output of the called process.

Call Process mechanism is based on the
standard Invoke activity. It abstracts out the
actual Call Process configuration to the
reference that the Invoke activity is calling.

After Migration: Call Process activity is
migrated as a Direct Call Process.

Signal-in Activity Migration

The following table provides information about the Signal-in activity migration from
ActiveMatrix BusinessWorks 5.x to ActiveMatrix BusinessWorks 6.x.

ActiveMatrix BusinessWorks 5.x ActiveMatrix BusinessWorks 6.x

Signal-In activities join an existing job
by comparing the key generated by
mapping process pipeline data to the
key field of the signal-in activity. The

Conversations is introduced to join an existing
process instance, which is based on a correlation
mechanism. It applies to all the activities receiving
a message after the process instance is created.
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ActiveMatrix BusinessWorks 5.x ActiveMatrix BusinessWorks 6.x

value is matched with the value
generated for the candidate event key
field of the signal-in activity by mapping
the signal-in output data.

A process instance can initialize a conversation
using an activity by initializing a conversation key
with the values mapped from the process pipeline
data. If the join activity generates a conversation
key value by evaluating the expression against the
message data, which matches the value of the
initialized conversation key, a message can join the
conversation.

l Input key mapping migrates as Conversation
Initiate

l Candidate Event Key migrates as
Conversation Join.

After Migration: Signal-in activity is migrated to an
ActiveMatrix BusinessWorks 6.x equivalent Signal-in
activity with a dummy conversation with Initiate
and Join as "true". This mechanism initiates the
conversation based on the process data mapped to
a key and matches it with a value that is generated
by mapping the activity output data.

Start and End Activity Migration

The following table provides information about the Start and End activities migration from
ActiveMatrix BusinessWorks 5.x to ActiveMatrix BusinessWorks 6.x.

ActiveMatrix BusinessWorks 5.x ActiveMatrix
BusinessWorks 6.x

The Start activity is a receiver that starts a process on receiving a
message that may be empty. The End activity sends a reply.

The Start activity is the first activity in a process definition
(process starters replace the Start activity when used in a process
definition).

The End activity is the last activity in a process definition.

The Start activity and
End activity are now
supported.
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Activator

In ActiveMatrix BusinessWorks 6.x, each application module has one Activator process that
has two service operations, On StartUp and On ShutDown. Any TIBCO Designer process
linked with the On Start and On ShutDown activity in ActiveMatrix BusinessWorks 5.x after
migration is simultaneously changed to a StartUp Operation activity and On ShutDown
Operation activity. The activator calls the start() and stop() methods to start or stop
the process.

Service and References

Service and References are defined at a process level.

ActiveMatrix BusinessWorks
5.x

ActiveMatrix BusinessWorks 6.x

SOAP services are used for
exchanging information in the
implementation of web
services relying on XML
message format sent over
HTTP and JMS.

Includes REST compliant services along with HTTP and JMS,
where the purpose of the service is to manipulate XML
representations of web resources using a uniform set of
stateless operations. When using a stateless operation, the
state is managed by the job itself instead of by the engine.
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Migrating ActiveMatrix BusinessWorks 5.x
Projects to ActiveMatrix BusinessWorks 6.x
Use the following options to migrate ActiveMatrix BusinessWorks 5.x projects to
ActiveMatrix BusinessWorks 6.x

l Project > Migrate BW Projects option in TIBCO Business Studio for BusinessWorks

l A command-line option

Migrating Projects Using TIBCO Business Studio for
BusinessWorks
This section describes how to use the Migrate BW Projects menu option in TIBCO Business
Studio for BusinessWorks.

Before you begin
l Perform validation and ensure that ActiveMatrix BusinessWorks 5.x project does not

have errors.

l Optionally, schemas without namespaces should be refactored before migration.

l Remove spaces in the namespace.

l Remove or update any retrieve WSDL processes.

l It is recommended to add missing namespaces for the schemas.

l Ensure that there are no spaces or special characters in folder names.

l Global variables with integer values and a String data type must be updated to data
type as Integer. Examples include timeouts, message size, and so on.

l Ensure that no two resources, such as schemas, WSDLs, and DTDs have the same
name when they have a common hierarchical structure or layout.

Procedure
1. In TIBCO Business Studio for BusinessWorks, choose Project > Migrate BW Projects.
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2. In the Project Migration Wizard dialog box, to migrate a single ActiveMatrix
BusinessWorks 5.x project, click Migrate Single BusinessWorks 5x Project.

To migrate multiple projects, click Migrate Multiple BusinessWorks 5.x Project.

When migrating a single ActiveMatrix BusinessWorks 5.x project, you can also migrate
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selective processes or subprocesses. Select the Select Processes for Migration
check box, and provide the required information as explained in Step 7, below.

After the required information is provided, the Select Processes button is displayed.

Note: Note: The Select Processes for Migration check box is disabled
when you select the Migrate Multiple BusinessWorks 5.x Projects option.
Use this check box only to migrate single projects.

The list of processes in the selected TIBCO ActiveMatrix BusinessWorks™ 5.x project
are displayed in the Project Migration Wizard dialog box. The processes can be
viewed in the Flat Hierarchy or in the Tree Hierarchy structures.

3. To select all the subprocesses under the main process, click Select Linked
Processes. Clear the check box for the process you do not want to migrate.

To view the static and dynamic processes that are selected for migration, click Show
Linked Process Hierarchy.

4. While migrating selective processes, to select or clear the already migrated existing
processes, on the Select Processes page of the Project Migration Wizard dialog box,
select the Re-Select Process check box.

Note: During the re-migration process, the module properties are not
changed.

5. Click Migrate Project.

6. Specify the relevant information in the following fields.

a. Click Browse in the Select Project(s) to be migrated field and provide the
location of the ActiveMatrix BusinessWorks 5.x project to migrate.

Note: Select CTRL+ Spacebar to retrieve the history of the last five
migrated project paths.

b. The Select Migrated Project Location field displays the location of the current
open workspace where the project is migrated. To provide a different
workspace, click Browse.

c. While migrating any project from version 6.6.1 of TIBCO ActiveMatrix
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BusinessWorks™ onwards, the default XPATH language for transitions is pre-set
to XPATH 1.0. Select XPATH 2.0 to set the XPATH language for transitions to
XPATH 2.0. The transitions are migrated by default to XPATH 2.0 for versions
prior to 6.6.1 of TIBCO ActiveMatrix BusinessWorks™.

Note: The XPATH language for transition is introduced to get rid of
invalid comparison or conversion issues on transitions or groups
while migrating ActiveMatrix BusinessWorks 5.x projects.

d. To browse for third party jars required for your project, click the Select Third
Party JAR's folder field.

e. The Single XPath Function Group Project check box is selected by default, to
create all custom XPaths as a single plugin project and under a single custom
XPath.

After migration, the custom XPath function group plugin project is included in
the application project. The classes folder is located in the
customXPathFunction.jar file, and is no longer available in the plug-in project.
This jar file is also added to the project class path.

f. In the Select ProjectLibs (DTLs) used by Project field, click Browse to select
the project libraries to be used for the project.

g. In the Select Java Libraries used by Project field, click Browse and provide
the location of the JAR files on disk if the ActiveMatrix BusinessWorks 5.x
project is using external JAR files in context with Java activities.

Important: TIBCO recommends that you place the external JAR files
in a single location.

These JAR files can then be in-lined in the migrated ActiveMatrix BusinessWorks
6.x project.

h. To generate the dot (.) properties file which is used for performing command-
line migration, click Export. For more information about the (.) properties file,
see Command line Configuration File Template.

i. To browse the (.) properties file which populates the referred 5.x project path
for migration, click Import.
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7. Click Migrate Project.

l The process count displayed on the Migrate page of the Project Migration
Wizard is inclusive of migration service agents.

l The tooltip available for the Migration progress bar displays the general
information about migration process.

l The Project Migration Wizard dialog box displays the migration status in blue
and green colors, where blue and green colors indicate the start and the
completion of the migration process respectively.

l To cancel the migration process anytime, in the Project Migration Wizard,
click Cancel.

8. Click Finish after the migration is complete.

Project with Subprocess after Migration
Subprocesses in ActiveMatrix BusinessWorks 6.x use a standardized concept of receiving
messages and replying to messages through a service.

Before Migration

After Migration

The Call Process is migrated as a Direct Call Process.
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Migrating Projects Using the Command Line
This section describes how to migrate the projects using the command line.

Usage: bwmigrator [-options] BW5Project...

where options include the following:

Option Description

-projectDir Location where ActiveMatrix BusinessWorks 6.x projects are generated.

BW5Project... Location\locations of ActiveMatrix BusinessWorks 5.x projects.

-propFile The bw6migration.properties file. The syntax for passing the
bw6migration properties file is bwmigrator.exe [-data <User_
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Option Description

Workspace>] -projectDir <BusinessWorks 6.x Target directory>
<BusinessWorks 5.x Project location> -propFile
<bw6migration.properties location>.

The template is at, <TIBCO_HOME>\bw\6.x\config\bw6migration_
template.properties.

Examples
l bwmigrator -projectDir <BW6_PROJECTS_HOME>\projects <TIBCO_
HOME>\5.9\examples\activities\file\File (Migrates single ActiveMatrix
BusinessWorks 5.x project.)

l bwmigrator -projectDir <BW6_PROJECTS_HOME>\projects <TIBCO_
HOME>\5.9\examples\activities\file\File <TIBCO_
HOME>\5.9\examples\activities\ftp\ftp (Migrates File and FTP ActiveMatrix
BusinessWorks 5.x projects.)

l bwmigrator -projectDir <BW6_PROJECTS_HOME>\projects <TIBCO_
HOME>\5.9\examples\activities (Migrates all ActiveMatrix BusinessWorks 5.x
projects in activities directory.)

l bwmigrator -projectDir <BW6_PROJECTS_HOME>\projects <TIBCO_
HOME>\5.9\examples\file <TIBCO_HOME>\5.9\examples\ftp (Migrates all
ActiveMatrix BusinessWorks 5.x Projects in File and FTP directories.)

Procedure
1. For Java migration enter the following command:

bwmigrator.exe -projectDir c:/temp -classpath <Jar Location Path> <BW 5.x
Project Path>

2. For non-Java migration enter the following command:
bwmigrator.exe -projectDir c:/temp <BW 5.x Project Path>

3. For the Eclipse environment, run the bwmigrator tool as described in step 2, but use
a temporary directory (not the Eclipse workspace directory) as a target.

In addition, to make the project visible in the current workspace, open the Eclipse UI,
select File > Import Existing Studio Project into Workspace, and specify the
temporary directory as the source.
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Command line Configuration File Template
The ActiveMatrix BusinessWorks 6.x migration configuration file, .properties file is a
template file that contains configurable properties to migrate design time libraries, custom
XPath functions, selected processes and projects using the command line.

To migrate projects using the command line migration option, open the .properties file
and paste the command from the .properties file into the command prompt, and execute
the command using the following format:

bwmigrator.exe [-data <User_Workspace>] -projectDir <BusinessWorks 6.x Target
directory> <BusinessWorks 5.x Project location> -propFile <.properties
location>

Note: Optionally, you can also modify the User_Workspace path. If the User_
Workspace path has been modified, make sure that the same path is provided
for the BW6 Target directory.

The properties to be configured to migrate design time libraries, custom XPath functions,
and selected processes are explained in the tables below.

Property Description

selectProcess The default value false will migrate all the processes.
Set the property to true to migrate only the specified processes.

selectLinkedProc
ess

The default value false migrates the specified main process.

For example, .process=<process1>,<process2>...

Set the property to true to migrate all the dependent processes, of the
specified main process.

For example,.process=<folder1/process1>,</process2>,.

Specifying the main process path will migrate all the processes that are
dependent on the main process.

.process Provide comma separated processes with relative process paths with
respect to the ActiveMatrix BusinessWorks 5.x project root folder as

Selective Migration
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Property Description

explained in the following example.

.process=Service/ZipInfo-
service1.serviceagent,TestService/getCityInfoTest.process,
Service/getCityInfoService.process,TestService/getCityDistance
TestJMS.process,
Service/getCityDistanceService.process,TestService/getCityInfo
TestJMS.process,
TestService/getCityDistanceTest.process,

Property Description

sharedModule The default value of this property is false, and will migrate the DTL as an
application module.
Set the property to true to create an ActiveMatrix BusinessWorks 6.x
shared module.

Design Time Library Migration (DTL)

Property Description

dtlDir Provide the project lib folder location here.

For example:

C:/Users/workspace1/folder/BW5DTLLib.projlib.

sharedModuleDirs Provide multiple directory locations using comma separated values.

For example:

C:/CLIWorkspace,C:/CLIWorkspace/SharedModuleProject1,....

Mapping DTLs to Shared Modules

Property Description

singleCXFGroupProject By default, the property is set to true, to migrate all the custom
XPath functions under a single custom XPath function group.

Custom XPath Migration
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Property Description

Set the property to false to migrate each custom XPath
function and create custom XPath function groups for each
individual XPath function.

thirdPartyCXFJarDir Provide the location of the third party JAR files that are referred
by the custom XPath function.

Post-Migration Manual Tasks
If you encounter problem markers that are related to activity input mapping, use the Show
Check and Repair and the Fix Type-Casting Errors functions to resolve the errors.

Show Check and Repair

Procedure
1. To clear the problem markers in the migrated project, click project.bwp.

2. Click the activity in your project, then click the Input tab.

3. Click the Show Check and Repair icon .

The Mapper Check and Repair window is displayed.

4. Click OK and run the project.
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Fix Type-Casting Errors
To fix the construct functions errors, click the Fix Type-Casting Errors icon .

Note: If the Project > Clean option does not work to resolve problem markers,
close and reopen the project.

HTTP Basic Sample
This section describes how to migrate an HTTP Basic sample.

Before you begin
Migrate the ActiveMatrix BusinessWorks 5.x project.

Procedure
1. Click the Incoming-HTTP-request (HTTP Receiver) activity.

2. Click the General tab.

3. In the Parameter table, change the Parameter Cardinality from Required to
Optional.

4. Click the Send-Request-to-Wiki-News (Send HTTP Request) activity and specify the
following three values on the Input tab.
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Input Type Values

RequestURI "/wiki/Main_Page"

Accept-Encoding "text/*, text/html, text/html;level=1"

Content-Type "text/html;charset=UTF-8"

5. Click the Send-Response-from-Wiki-News (Send HTTP Response) activity and
specify the value for Content-Type on the Input tab.

Custom XPath Migration
Some manual tasks need to be performed after custom XPath migration. These tasks
impact Design-time.
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Design Time

This section describes how to provision migrated custom XPath functions into ActiveMatrix
BusinessWorks 6.x.

Procedure
1. Export the custom XPath function plug-ins into the Host repository. To do this, right-

click on the XPath Function Plug-in, and select Plug-in Development/Deployable
Plug-ins and fragments.

2. Select Install into .host Repository and, click Finish.

3. Restart and refresh your workspace.

This results in the validation errors related to XPath functions not visible.

Custom XPath Migration Using the Command Line
Set the following properties to migrate custom XPath functions using the
bw6migration.properties file.

Property Description

singleCXFGroupProject By default, the property is set to true, and migrates all the
custom XPath functions under a single custom XPath function
group.
Set the property to false to migrate each custom XPath
function and create custom XPath function groups for each
individual XPath function.

thirdPartyCXFJarDir Provide the location of the third party JAR files that are referred
by the custom XPath function.
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Migrating Design Time Libraries (DTL) as Shared
Modules
ActiveMatrix BusinessWorks 5.x design time library source projects are migrated as
ActiveMatrix BusinessWorks 6.x shared modules.

Migrating Design Time Libraries Using TIBCO Business Studio for
BusinessWorks

Use the ActiveMatrix BusinessWorks 6.x framework to migrate ActiveMatrix BusinessWorks
5.x projects where the business process uses design time libraries to define processes,
resources, and subprocesses.

You can migrate the design time libraries using the following options:

l Project > Migrate BW Projects option in TIBCO Business Studio for BusinessWorks

l The command-line option

Procedure
1. In the Project Migration Wizard dialog box, click Migrate Single BusinessWorks 5.x

Project and select the Migrate as Shared Module check box.

2. Provide the Project Location details and the XPATH Function Group Configuration
details if a custom XPath is used in the project.

3. To browse for third party jars only if your project contains a custom XPath, click the
Select Third Party JARs folder field .

4. Click Migrate Project.

Result
After migration, view the folder structure of the resources, including the resource, schema,
wsdl, and so on that are available in the shared module under the Module Descriptors >
Provides tab.

After migration, do not perform refactoring operations on any of the resources, such as the
schema, ActiveMatrix BusinessWorks 6.x shared resources, and service definitions. The
resource properties, and naming conventions must be retained as they are. Mapping issues,
if any, can be corrected, and resource specific properties of the shared resources can be
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changed.

Limitations
l Shared module migration does not support ActiveMatrix BusinessWorks 5.x AE

schemas. AE Schemas are migrated as part of the application module.

l Custom XPath function project duplication should be managed manually by deleting
the duplicate source projects.

l DTL migration does not support the Process Name Dynamic Override feature of the
Call Process activity. Instead, add the process name manually.

Migrating Application Modules
ActiveMatrix BusinessWorks 5.x projects using design time libraries can be migrated as
application modules by linking the corresponding shared modules to the DTL libraries.
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Select the Link DTL to Shared Module check box.

Select the required DTL project, and click OK.
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Mapping the DTL to the <Do Not Migrate> option does not link the DTL to the shared
module.

Note: Multiple DTL libraries can be linked to one shared module. After migration
all the DTL libraries refer to the same shared module to resolve resource
references.

Migrating Design Time Libraries Using Command
line
Design time library source projects can be migrated as shared modules using the command
line.

Set the following properties to migrate DTL projects as a shared module using the
bw6migration.properties file.

Property Description

sharedModule Set the property to true to create an ActiveMatrix BusinessWorks 6.x
shared module.

Set the property to false to migrate the DTL as an application module.

Note: The shared module and the application module must be maintained in the
same workspace while performing migration using the command line.

Mapping a Design Time Library to a Shared Module
Set the following properties to link a DTL library to the shared module.

Property Description

dtlDir Provide the project lib folder location. For example,



TIBCO ActiveMatrix BusinessWorks™ Migration

89 | Migration Scenario

Property Description

C:/Users/workspace1/folder/BW5DTLLib.projlib.

sharedModuleDirs Provide the shared module location. You can provide multiple
directory locations using comma separated values. For example,
C:/CLIWorkspace,C:/CLIWorkspace/SharedModuleProject1,....

Using the Quick Fix Option to Resolve XSLT out
of Sync Errors
After migrating a project, use the Quick Fix option to resolve XSLT out of Sync errors in the
project.

Before you begin
Set the minimum JVM heap size to either 4GB, 6GB or 8GB, keeping in mind the size of the
project. For additional instructions, see Specifying JVM Heap Size in TIBCO ActiveMatrix
BusinessWorks™ Performance Benchmarking and Tuning.

After migrating a project, follow these steps:

Procedure
1. Turn off the Auto Build, which is enabled by default, by selecting Project > Build

Automatically.

2. From the Problems tab, click the downward arrow icon, and select Configure
Contents.

The Configure Contents window is displayed.

3. Clear the Use item limits check box and select OK.

This causes all of the errors in the project to display.

4. From the Problems tab, right-click on an XSLT out of Sync error, and select Quick
Fix.

5. Click Select All.
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6. Click Finish.

7. Clean the project to fix broken mappings that might have occurred.

8. To fix broken mappings, select Project > Clean.

Result
The number of XSLT out of Sync errors in the migrated project are either reduced or fully
resolved. If there are a few XSLT out of Sync errors still lingering, use the Quick Fix option
to resolve these problems. Make sure the Auto Build is turned off during this process.
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Migration Process Outline
The migration mechanism takes ActiveMatrix BusinessWorks 5.x projects and converts them
to their equivalent in ActiveMatrix BusinessWorks 6.x.

The process flow in the project is migrated as is for the following:

l The activities and their associated mappings

l The transitions and their associated conditions

l Groups

5.x Project in TIBCO Designer 6.x Project in TIBCO Business Studio for BusinessWorks

Process ActiveMatrix BusinessWorks 6.x Process

Schema Schema

WSDL WSDL

Shared Resource ActiveMatrix BusinessWorks 6.x Shared Resource

ActiveMatrix BusinessWorks Project Migration

Note: While migrating projects, if a project rests in a multiple folder hierarchy
structure and contains WSDLs, or schemas, or both, the folder names must be
unique. If the folder names are not unique the project can run into design time
issues due to incorrect namespaces and imports.

Note: For ActiveMatrix BusinessWorks 6.x, spaces are not allowed in the
namespace.

Project Migration Diagram
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The following image shows the project process flow after the migration. Activities,
transitions, and their associated mappings visible in ActiveMatrix BusinessWorks 5.x project
in TIBCO Designer are displayed in ActiveMatrix BusinessWorks 6.x project in TIBCO
Business Studio for BusinessWorks.
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Migrated Project - Before and After
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Frequently Asked Questions
What do I do... Answer

When migrated process shows
mapping errors?

1. Go to Menu > Project > Clean and click Clean
All Projects.

2. Go to the Activity Input with the Mapping Error.
Click Show Check and Repair and fix existing
errors.

3. Click Fix Type Casting Errors.

4. If the error still persists, check the expression and
do the necessary corrections.

When processes have unresolved
WSDL references?

1. Close and reopen the project.

2. If this does not fix the references, heck the WSDL
Interface value on the General tab of the Process
Service.

When Java Invoke activities show
Input Configuration Error after
migration?

1. Go to the General tab of the Java Invoke activity
and check whether the Class Name is available in
the workspace. If available, re-select the Java
class.

2. If the class is not available, check whether the
JAR file packaging the Java class is available.
Otherwise, copy the JAR file to the "lib" folder
and reselect the Java class.

When activities in the Catch block
show Mapping errors?

The Catch Block activities does not have the visibility
to the output of the activities from the main process.

Re-map the activity input accordingly. This is similar to
the Java try or catch constructs.

When Variable not defined error 1. In ActiveMatrix BusinessWorks 6.x the Iterate
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What do I do... Answer

for Iterate Group Index variable is
used outside the Iterate scope?

Group Index Variable does not have visibility
outside the Iterate scope.

2. Define a process variable of type integer, map it
to the Iterate Group Index variable, and use the
variable in the process scope.

When a ActiveMatrix BusinessWorks
5.x activity migrates as Empty or
Rescue activity in ActiveMatrix
BusinessWorks 6.x?

The ActiveMatrix BusinessWorks 5.x activity migrates as
Rescue activity, if the migration framework fails to
migrate.

1. Check the ActiveMatrix BusinessWorks 5.x project

2. Add the corresponding activity in the ActiveMatrix
BusinessWorks 6.x project

3. Redo the mappings.

After migrating a project using the
tib:concat-sequence-format(),
the output returns errors.

The function tib:concat-sequence-format() does not
accept a string as its return value for node set.

After migration, replace the tib:concat-sequence-
format() with the string-join() function.

When a group is around the
activities and the XPath condition
over the group is not satisfied after
migration, the Expected Non
Repeating got repeating error is
displayed.

1. Verify the XPath condition and resolve the group
issues (for example, iterator, for-each...)

2. Re-map the same from the group.

When the Variable not defined
error is displayed post migration for
multiple variables created in the
input of any activity and each
variable is created with the
condition on another variable.

1. Remove all the variables

2. Recreate the variables

3. Add the mappings again. In this case the back-
end references are also removed.

4. Delete the XPath on the variables one by one and
re-correct them. This also resolves the issue
sometimes.
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What do I do... Answer

When the Unresolved reference
schema error is displayed.

Reconfigure the broken module variables. Redo all the
mappings as they break due to reconfiguration.

When the Catch-All End error is
not configured.

When a Catch All fault handler is used in a ActiveMatrix
BusinessWorks5.x project, on migration the fault
handler is converted as expected but an End activity is
created in place of a Catch All activity. An End activity
without any input is created. Delete the end activity
and to resolve the issue.

Schema references issues post
migration

References of schemas that are imported in another
schema are not found. Delete the import and add it
again. The references are updated with the correct
namespace and the namespace issues are resolved.

When you map an integer value, for
example 1, to a decimal field,
expecting the output in the decimal
field to be 1, but, instead, the
decimal field result is 1.0.

Create a new Mapper activity using the same naming
and mappings from the existing mapper activity.

Once all the inwards and outwards mappings are done,
delete the old Mapper activity, which is already
migrated, and point the transitions to the newly
created mapper activity.

There is no tokenize-allow-empty
() function in ActiveMatrix
BusinessWorks 6.x.

After migration to ActiveMatrix BusinessWorks 6.x, the
tokenize() function can yield the same results as the
tib:tokenize-allow-empty() and tib:tokenize()
functionsof ActiveMatrix BusinessWorks 5.x.

When a mapper activity that has a
tokenize function inside a for-each
expression, throws a Null Input at
runtime?

Post migration, convert the XSLT version in the activity
from 1.0 to 2.0, since in version 1.0 the for-each
expression requires things to be evaluated to a node-
set.

The Tokenize function creates a sequence of string
atoms, which is not node-set.

In 2.0, the for-each expression must be evaluated to
sequence, which covers the sequence of atoms and
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What do I do... Answer

node scenario.

After migration, when a boolean
always evaluates to false with XSLT
1.0 and validation off.

1. Navigate to Windows > Preferences > Mapper.

2. Select the Assume all inputs untyped check
box.

3. Click Apply, and then OK.

4. Clean the project. After the errors related to
untyped input are displayed, use the Quick Fix
option to resolve them.

5. Execute the project.

After migration, when there is a
invalid comparison, or conversion
error in a transition or a group.

1. Navigate to Windows > Preferences > Mapper.

2. Select the Enable Quick fix to change Xpath
version from 2.0 to 1.0 check box.

3. Click Apply, and then OK.

4. Clean the project.

5. On the Problems tab, right-click and select the
Quick Fix option for the XPath Version 2.0.
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website,
mainly in HTML and PDF formats.

The Product Documentation website is updated frequently and is more current than any
other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO ActiveMatrix
BusinessWorks™ page:

l TIBCO ActiveMatrix BusinessWorks™ Release Notes

l TIBCO ActiveMatrix BusinessWorks™ Installation

l TIBCO ActiveMatrix BusinessWorks™ Application Development

l TIBCO ActiveMatrix BusinessWorks™ Bindings and Palettes Reference

l TIBCO ActiveMatrix BusinessWorks™ Concepts

l TIBCO ActiveMatrix BusinessWorks™ Error Codes

l TIBCO ActiveMatrix BusinessWorks™ Getting Started

l TIBCO ActiveMatrix BusinessWorks™ Migration

l TIBCO ActiveMatrix BusinessWorks™ Performance Benchmarking and Tuning

l TIBCO ActiveMatrix BusinessWorks™ REST Implementation

l TIBCO ActiveMatrix BusinessWorks™ Refactoring Best Practices

l TIBCO ActiveMatrix BusinessWorks™ Samples

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-activematrix-businessworks
https://docs.tibco.com/products/tibco-activematrix-businessworks
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How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:

l To access the Support Knowledge Base and getting personalized content about
products you are interested in, visit our product Support website.

l To create a Support case, you must have a valid maintenance or support contract
with a Cloud Software Group entity. You also need a username and password to log
in to the product Support website. If you do not have a username, you can request
one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
TIBCO Community.

https://support.tibco.com/s/
https://support.tibco.com/s/
https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED,
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, ActiveSpaces, Business Studio,
TIBCO Business Studio, TIBCO Designer, TIBCO Enterprise Administrator, Enterprise Message Service,
Rendezvous, and TIBCO Runtime Agent are either registered trademarks or trademarks of Cloud
Software Group, Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only. You acknowledge that all
rights to these third party marks are the exclusive property of their respective owners. Please refer to
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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Cloud SG software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the “readme” file
for the availability of a specific version of Cloud SG software on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S), THE PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 2001-2023. Cloud Software Group, Inc. All Rights Reserved.

https://www.tibco.com/patents
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